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1. Důležité

1.	 Důležité
Tato elektronická uživatelská příručka je 
určena pro každého uživatele tohoto monitoru 
Philips. Před používáním monitoru si přečtěte 
tuto uživatelskou příručku. Obsahuje důležité 
informace a poznámky k používání vašeho 
monitoru.
Záruka Philips je platná, pokud je výrobek 
používán pro navrženou potřebu v souladu 
s návodem a po přiložení originálu faktury 
nebo pokladním dokladem, označujícím datum 
nákupu, jméno prodejce a modelové a výrobní 
číslo výrobku.

1.1	 Bezpečnostní opatření a údržba

	 Varování
Použití kontrol, úprav nebo postupů jiným 
způsobem než je stanoveno v této dokumentaci 
může vést k ohrožení šokem, elektrickým a/
nebo mechanickým rizikům.
Přečtěte si a dodržujte tyto instrukce při 
zapojování a používání vašeho PC monitoru.

Používání
•	 Nevystavujte monitor přímému slunečnímu 

záření, velmi silným jasným světlům a 
udržujte jej mimo dosah jiných zdrojů tepla. 
Dlouhé vystavení tomuto typu prostředí 
může mít za následek změnu barev a 
poškození monitoru.

•	 Odstraňte veškeré předměty, které by 
mohly spadnout do větracích otvorů nebo 
zabránit dostatečnému chlazení elektroniky 
monitoru. 

•	 Nezakrývejte větrací otvory ve skříňce.
•	 Umístěte monitor na takové místo, ze 

kterého bude elektrická zástrčka a zásuvka 
snadno přístupná.

•	 Jestliže jste vypnuli monitor odpojením 
napájecího kabelu nebo kabelu napájecího 
adaptéru, před připojením kabelu počkejte 
6 sekund, aby monitor fungoval normálně.

•	 Vždy používejte napájecí kabel schválený 
společností Philips. Pokud napá jecí kabel 
chybí, obraťte se na nejbližší servisní 
středisko. (Viz informace o střediscích 
zákaznické péče)

•	 Během používání nevystavujte monitor 
nadměrným otřesům nebo nárazům.

•	 Při používání nebo přemísťování do 
monitoru nekopejte a zabraňte případnému 
pádu.

Údržba
•	 Aby byl monitor chráněn před možným 

poškozením, nevyvíjejte na panel LCD 
nadměrný tlak. Při přemísťování zvedejte 
monitor za rám; při zvedání monitoru 
nesahejte rukou nebo prsty na panel LCD.

•	 Nebudete-li monitor delší dobu používat, 
odpojte jej ze zásuvky.

•	 Před očištěním mírně navlhčeným 
hadříkem monitor odpojte ze zásuvky. 
Je-li vypnuté napájení, lze obrazovku otřít 
suchým hadříkem. K čištění monitoru nikdy 
nepoužívejte organická rozpouštědla, jako 
například alkohol nebo čističe s obsahem 
čpavku.

•	 Zabraňte nebezpečí úrazu elektrickým 
proudem nebo trvalého poškození 
monitoru a chraňte monitor před prachem, 
deštěm, vodou nebo nadměrně vlhkým 
prostředím.

•	 Pokud dojde k namočení monitoru, co 
nejdříve jej osušte suchým hadříkem. 

•	 Vnikne-li do monitoru cizí látka nebo voda, 
ihned vypněte napájení a odpojte napájecí 
kabel. Odstraňte cizí látku nebo vodu 
z monitoru a odešlete jej do servisního 
střediska.

•	 Monitor neskladujte ani nepoužívejte 
na místech vystavených teplu, přímému 
slunečnímu záření nebo extrémním 
teplotám.

•	 Chcete-li zachovat optimální výkonnost 
monitoru a prodloužit jeho životnost, 
používejte jej na místě, které splňuje 
následující rozsahy teplot a vlhkosti. 
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•	 Teplota: 0-40°C 32-95°F
•	 Vlhkost: 20-80% relativní vlhkosti

Důležité informace pro vypálení obrazu/
zdvojeného dosvitu
•	 Před ponecháním monitoru bez dozoru 

vždy aktivujte spořič obrazovky. Bude-li 
na vašem monitoru zobrazen neměnící 
se statický obsah, vždy aktivujte aplikaci 
pro pravidelnou obnovu obrazovky. 
Dlouhodobé nepřerušované zobrazení 
nehybného nebo statického obrazu může 
způsobit „vypálení“ obrazovky, rovněž 
známé jako „dosvit“ nebo „zobrazení 
duchů“. 
„Vypálení“, „dosvit“ nebo „zobrazení 
duchů“ je dobře známý jev u technologie 
panelů LCD. V mnoha případech „vypálení“, 
„dosvit“ nebo „zobrazení duchů“ postupně 
zmizí po určité době mimo provoz.

	 Výstraha
Selhání aktivace spořiče obrazovky nebo aplikace 
pro pravidelné aktualizování obrazovky může mít 
za následek vážné příznaky „vypálení“, „dosvitu“ 
nebo „zdvojeného dosvitu“, které nezmizí a 
nelze je opravit. Na výše uvedené poškození se 
nevztahuje záruka..

Servis
•	 Kryt pláště může otevřít pouze kvalifikovaný 

servisní pracovník.
•	 Pokud je pro opravu vyžadována 

dokumentace nebo integrace, obraťte se 
na nejbližší servisní středisko. (Viz kapitola 
„Středisko zákaznické péče“) 

•	 Informace o převážení najdete v části 
„Technické údaje“.

•	 Neponechávejte monitor v autě nebo v 
zavazadlovém prostoru auta na přímém 
slunci.

	 Poznámka
Pokud monitor nefunguje správně nebo pokud 
si nejste jisti, jaké kroky je třeba provést po 
provedení pokynů v této příručce, obraťte se na 
servisního pracovníka.

1.2	 Vysvětlení zápisu
Následující pododdíly popisují způsob zápisu, 
který se používá v této příručce. 

Poznámky, upozornění a výstrahy
Na stránkách této příručky můžete narazit na 
text, který je opatřený symbolem a je vytištěn 
tučně nebo kurzívou. Takové úseky obsahují 
poznámky, upozornění a výstrahy. Jejich použití 
je následující:

	 Poznámka
Tento symbol označuje důležité informace a 
návrhy, které pomáhají lépe využít počítačový 
systém.

	 Upozornění
Tento symbol označuje informace, které 
objasňují, jak se vyhnout možnému poškození 
zařízení nebo ztrátě dat.

	 Výstraha
Tento symbol označuje nebezpečí tělesného 
ublížení a vysvětluje, jak se danému problému 
vyhnout.
Některé výstrahy se mohou objevit v různé 
podobě a nemusí být uvozeny symbolem. V 
takovém případě je konkrétní vyznačení výstrahy 
nařízeno úřadem pro regulaci.
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1.3	 Likvidace produktu a obalového 
materiálu

Likvidace elektrických a elektronických 
zařízení - WEEE

This	marking	on	the	product	or	on	its	
packaging	illustrates	that,	under	European	
Directive	2012/19/EU	governing	used	electrical	
and	electronic	appliances,	this	product	may	
not	be	disposed	of	with	normal	household	
waste.	You	are	responsible	for	disposal	of	
this	equipment	through	a	designated	waste	
electrical	and	electronic	equipment	collection.	
To	determine	the	locations	for	dropping	off	
such	waste	electrical	and	electronic,	contact	
your	local	government	office,	the	waste	disposal	
organization	that	serves	your	household	or	the	
store	at	which	you	purchased	the	product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please find out about the local regulations on 
how to dispose of your old monitor and packing 
from your sales representative. 

Taking back/Recycling Information for 
Customers
Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation innational take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors,  
which recycle  all materials (products and 
related packaging material) in accordance with 
all Environmental Laws and taking back program 
with the contractor company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit 

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page

http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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2. Sestavení monitoru

2.1	 Instalace

Obsah krabice

M
51

93
V1

T 
H

70
G

18
C

18
13

03
A
   

   

193V5Register your product and get support at

www.philips.com/welcome

Quick

Start

*VGA Cable Power Cable 

Namontujte stojánek podstavce
1.	 Umístěte monitor obrazovkou dolů na

měkký a hladký podklad, aby nedošlo k 
poškrábání obrazovky.

2.	 Připojte/nasuňte sloupek podstavce k
monitoru tak, aby zacvakl na místo. 

3.	 Uchopte monitor oběma rukama a
připevněte stojánek podstavce do sloupku
podstavce.

* HDMI 

* V závislosti na zemi
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Připojení k počítači

D-SUB

AC IN

3

	 Vstup střídavého napájení
	 Vstup VGA
	 �ámek proti krádeži Kensington

Připojení k počítači
1.	 Pevně připojte napájecí kabel k zadní straně

monitoru.
2.	 Vypněte počítač a odpojte jeho napájecí

kabel.
3.	 Připojte signálový kabel monitoru do video

konektoru na zadní straně počítače.
4.	 Zapojte napájecí kabel počítače a monitoru

do nejbližší zásuvky.
5.	 Zapněte počítač a monitor. Jestliže se

na monitoru objeví obraz, instalace je
dokončena.

2.2	 Ovládání monitoru

Popis výrobku z čelního pohledu

193V5LHSB2

4

4

Vstup	střídavého	napájení 	
Vstup	VGA
Vstup HDMI
ámek	proti	krádeži	Kensington

193V5LSB2

Popis	zobrazení	funkcí	na	obrazovce

Co	je	nabídka	na	obrazovce	(OSD)?
Funkcí	nabídky	obrazovky	(On-Screen	Display,	
OSD)	jsou	vybaveny	všechny	monitory	
LCD	Philips.	Umožňuje	koncovému	uživateli	
upravovat	vlastnosti	obrazovky	nebo	vybírat	
funkce	monitoru	přímo	prostřednictvím	
zobrazeného	okna	s	pokyny.	Níže	je	uveden	
příklad	příjemného	rozhraní	obrazovky:

Slouží k ZAPNUTÍ a VYPNUTÍ 
napájení monitoru.

Nastavení úrovně jasu.

Nastavení úrovně kontrastu.

Automatické nastavení monitoru.

Nastavení jazyka

Zobrazení informací

Ukončení OSD

i

or

193V5LHSB2: 

Slouží	ke	změně	zdroje	
vstupního	signálu.
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Jak nastavit nabídku OSD jediným tlačítkem?
1.Tlačítko na dolní straně předního rámečku má
funkce vypínače a nastavení nabídky OSD.

Nabídka OSD
Níže je uveden celkový pohled na strukturu 
OSD. Tento přehled můžete využít, budete-li 
chtít později prozkoumat různá nastavení.

Main menu

Picture
Wide Screen, 4:3

0~100

0~100

0~100

Picture Format

Brightness

Contrast

OSD Settings 0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time Out

Setup

0~100

On, Off

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution 
Notification

Reset

Information

Language

Color 6500K, 9300K

Red: 0~100
Green: 0~100
Blue: 0~100

Color Temperature
sRGB

User Define

Audio

On, Off

Volume

Mute(available for 
selective models)

VGA
DVI (available for selective models)
HDMI (available for selective models)

Input

On, OffSmartContrast

On, OffOverScan

Audio In, HDMIAudio Source

English, Deutsch, Español, Ελληνική, Français, Italiano,
Maryar, Nederlands, Português, Português do Brazil,
Polski , Русский, Svenska, Suomi, Türkçe, Čeština,
Українська, 简体中文, 繁體中文,日本語,한국어

2.Jedním	stisknutím	dolního	tlačítka	zapněte
monitor.

3.Nyní	dalším	stisknutím	dolního	tlačítka	na
předním	rámečku	vstupte	do	nabídky	OSD

4.Nyní	můžete	rychlým	opakovaným	stisknutím
dolního	tlačítka	vybrat	libovolnou	funkci.	
Tisknutím	tlačítka	se	bude	modré	políčko	
posouvat	vpravo.	Jakmile	modré	políčko	označí	
požadovanou	volbu,	můžete	dolní	tlačítko	
uvolnit.	Výběr	je	jednosměrný:	vždy	postupuje	
jedním	směrem	a	potom	se	vrátí	na	začátek	
nabídky.

5.Modré	políčko	zůstane	na	vybrané	funkci
přibližně	3	sekundy,	ikona	funkce	třikrát	zabliká	
pro	potvrzení	výběru	na	1.	úrovni	nabídky	OSD	
a	funkce	bude	aktivována.	

6.Chcete-li	vybrat	požadovaný	jazyk,	stiskněte
dolní	tlačítko,	v	nabídce	OSD	vyberte	symbol	
„zeměkoule“	a	počkejte,	až	se	aktivuje.	V	
nabídce	se	zobrazí	několik	jazykových	možností.	
Opakovaným	stisknutím	dolního	tlačítka	
procházejte	jazyky.	Ponecháním	modrého	
políčka	na	vybraném	jazyku	bude	proveden	
jeho	výběr	a	aktivace.

7.Chcete-li	nastavit	jas	nebo	kontrast,	stiskněte
dolní	tlačítko,	vyberte	a	aktivujte.	Dalšími	
stisknutím	dolního	tlačítka	upravte.	Výběr	je	
jednosměrný:	vždy	postupuje	jedním	směrem	a	
potom	se	vrátí	na	začátek	nabídky.

193V5LHSB2: 
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Poznámka k rozlišení
Tento monitor je určen pro optimální výkon při 
nativním rozlišení 1366 x 768 při 60 Hz. Když je 
monitor zapnut při jiném rozlišení, na obrazovce 
se zobrazí výstraha: Pro optimální výsledek 
použijte rozlišení 1366 x 768 při 60 Hz.

	 Fyzické funkce

Náklon

2.3	 Odpojte stojánek podstavce a 
podstavec

Demontáž stojánku podstavce
Než začnete demontovat podstavec monitoru, 
postupujte podle pokynů níže, aby se zabránilo 
jakémukoli možnému poškození nebo zranění.
1.	 Umístěte monitor obrazovkou dolů na

měkký podklad, aby nedošlo k poškrábání 
obrazovky.

2.	 Stiskněte zajišťovací svorky a oddělte
stojánek podstavce od sloupku podstavce.

1

3.	 Pro odpojení sloupku podstavce stiskněte
uvolňovací tlačítko.

2



8

2. Sestavení monitoru

	 Poznámka 
Tento monitor je kompatibilní s 100mm x 
100mm	montážním rozhraním kompatibilním 
se standardem VESA.

100mm

100mm
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3. Optimalizace Obrazu

3.1	 SmartContrast

	 Co je to?
Jedinečná technologie, která dynamicky analyzuje 
zobrazený obsah a automaticky optimalizuje 
kontrastní poměr monitoru LCD pro maximální 
vizuální čistotu a požitek ze sledování. Zvyšuje 
podsvícení pro jasnější, ostřejší a jasnější obraz 
nebo snižuje podsvícení pro jasné zobrazení 
obrazu s tmavým pozadím. 

	 Proč to potřebuji?
Žádáte nejvyšší vizuální čistotu a pohodlí 
sledování jakéhokoli typu obsahu. SmartContrast 
dynamicky řídí kontrast a upravuje podsvícení 
pro jasné, ostré a jasné zobrazení her a videa 
nebo pro zobrazení jasného, čitelného textu 
pro kancelářskou práci. Omezením spotřeby 
monitoru šetříte náklady a prodlužujete život 
vašeho monitoru. 

	 Jak to funguje?
Po aktivaci bude funkce SmartContrast v 
reálném čase analyzovat zobrazený obsah a 
upravovat barvy a řídit intenzitu podsvícení. Tato 
funkce bude dynamicky vylepšovat kontrast pro 
skvělý zážitek při prohlížení fotografií nebo hraní 
her.

3.2	 Philips SmartControl Lite
Nový software SmartControl Lite od 
společnosti Phillips umožňuje ovládat monitor 
prostřednictvím snadno použitelného grafického 
rozhraní na obrazovce. Složitá nastavení jsou 
minulostí, protože tento uživatelský příjemný 
software vás provede jemným vyladěním 
rozlišení, kalibrací barev, nastavením frekvence/
fáze, nastavením bílého bodu RGB atd.

Tento software založený na přitažlivých 
animovaných ikonách kompatibilní se systémem 
Windows 7, který je vybaven nejnovější 
technologií v jádrovém algoritmu pro rychlé 

zpracování a odezvu, je připraven rozšířit vaši 
zkušenost s monitory Philips!

Instalace
• Postupujte podle pokynů a dokončete

instalaci.
• Můžete spustit po dokončení instalace.
• Chcete-li spustit později, můžete klepnout

na zástupce na pracovní ploše nebo na
panel nástrojů.

První spuštění – Wizard (Průvodce)
• Při prvním spuštění po instalaci přejde

SmartControl Lite automaticky na Wizard
(Průvodce).

• Tento průvodce vás provede podrobným
nastavením výkonu monitoru.

• Průvodce můžete rovněž spustit později z
nabídky Plug-in (Zásuvný modul).

• Další možnosti můžete nastavit bez
průvodce prostřednictvím podokna
Standard (Standardní).
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�Spuštění s podoknem Standard 
(Standardní):

Nabídka Adjust (Nastavení):
• Nabídka Adjust (Nastavení) umožňuje

upravit Brightness (Jas), Contrast (Kontrast), 
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlišení).

• Můžete postupovat podle pokynů a provést
nastavení.

• Cancel (Storno) vyzívá uživatele, chcete-li
ukončit instalaci.
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Nabídka Color (Barva):
• Nabídka Color (Barva) umožňuje upravit

RGB, Black Level (Úroveň černé), White
Point (Bílý bod), Color Calibration (Kalibrace
barev).

• Můžete postupovat podle pokynů a provést
nastavení.

• V následující tabulce vyhledejte položku
podnabídky na základě vašeho vstupu.

• Příklad pro Color Calibration (Kalibrace
barev)
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• Zobrazí nastavení aktuálních předvoleb.
• Zaškrtnuté tlačítko aktivuje funkci.

Zaškrtávací políčko je přepínač.
• Položka Enable Context Menu (Povolit

místní nabídku) na pracovní ploše je ve
výchozí konfiguraci zaškrtnutá (Zapnuto).
Po aktivaci položky Enable Context
Menu (Povolit místní nabídku) se zobrazí
výběry SmartControl Premium pro funkce
Select Preset (Vybrat předvolbu) a Tune
Display (Ladění zobrazení) na pracovní
ploše klepnutím pravým tlačítkem myši na
místní nabídku. Volbou možnosti Disabled
(Deaktivováno) bude položka SmartControl
Premium odstraněna z místní nabídky
pravým tlačítkem myši.

• Položka Enable Task Tray (Povolit ikonu na
hlavním panelu) je ve výchozí konfiguraci
zaškrtnutá (Zapnuto). Po aktivaci položky
Povolit místní nabídku se zobrazí nabídka
SmartControl Lite na hlavním panelu.
Klepnutím pravým tlačítkem myši na ikonu
na hlavním panelu se zobrazí možnosti
nabídky Help (Nápověda), Technical
Support (Odborná pomoc), Check for
Update (Vyhledat aktualizace), About
(O aplikaci) a Exit (Konec). Když je
deaktivována položka Enable task tray menu
(Povolit nabídku na hlavním panelu), ikona
na hlavním panelu zobrazuje pouze možnost
EXIT (KONEC).

1.	 Tlačítko „Show Me“ (Předvést) spustí
výukový program pro kalibraci barev.

2.	 Start (Spustit) – zahájí sekvenci kalibrace
barev o 6. krocích.

3.	 Quick View (Rychlé zobrazení) načte
zobrazení před/po.

4.	 Chcete-li se vrátit na hlavní stránku Color
(Barva), klepněte na tlačítko Cancel
(Storno).

5.	 Enable color calibration (Povolit kalibraci
barev) – ve výchozí konfiguraci je zapnuto. 
Pokud tato položka není zaškrtnuta, kalibraci
barev nelze provést a tlačítka rychlé
zobrazení nejsou k dispozici.

6.	 Na kalibrační obrazovce musí být zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace) 
první barvy:

• Tlačítko Previous (Předchozí) je
deaktivováno až na obrazovku druhé barvy.

• Tlačítko Next (Další) slouží k přechodu na
následující cíl (6 cílů).

• Tlačítko Konečný slouží k přechodu na File
> Presets (Soubor > podokno Předvolby).

• Tlačítko Cancel (Storno) slouží k ukončení
uživatelského rozhraní a k návratu na
stránku zásuvných modulů plug-in.

Options>Preferences (Možnosti>Předvolby) –
Tato možnost bude aktivní pouze po výběru 
položky Preferences (Předvolby) v rozevírací 
nabídce Options (Možnosti). Na nepodporova-
ném zobrazovacím zařízení s podporou DDC/
CI jsou k dispozici pouze karty Help (Nápověda) 
a Options (Možnosti).
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• Položka Run at Startup (Spustit při startu) je
ve výchozí konfiguraci zaškrtnutá (Zapnuto).
Když je tato položka deaktivována, funkce
SmartControl Lite se nespustí při startu
nebo nebude na hlavním panelu. Funkci
SmartControl Lite lze spustit pouze
prostřednictvím zástupce na pracovní
ploše nebo prostřednictvím souboru
programu. Když toto políčko není zaškrtnuté
(Deaktivováno), žádná předvolba nastavená
pro spuštění při startu nebude načtena.

• Enable transparency mode (Aktivovat režim
průhlednosti) (Windows 7, Vista, XP).
Výchozí nastavení je 0 % neprůhlednost.

Options>Input (Možnosti>Vstup) – Tato 
možnost bude aktivní pouze po výběru 
položky Input (Vstup) v rozevírací nabídce 
Options (Možnosti). Na nepodporovaném 
zobrazovacím zařízení s podporou DDC/CI 
jsou k dispozici pouze karty Help (Nápověda) 
a Options (Možnosti). Žádné další karty funkce 
SmartControl Lite nejsou k dispozici.

• Zobrazí podokno s pokyny Source (Zdroj)
a nastavení aktuálního zdroje vstupu.

• U zobrazovacích zařízení s jedním vstupem
není toto podokno zobrazeno.

Options>Audio (Možnosti>Zvuk) – Tato 
možnost bude aktivní pouze po výběru položky 
Audio (Hlasitost) v rozevírací nabídce Options 
(Možnosti).

Na nepodporovaném zobrazovacím zařízení s 
podporou DDC/CI jsou k dispozici pouze karty 
Help (Nápověda) a Options (Možnosti).

Help>User Manual (Nápověda>Uživatelská 
příručka) – Tato možnost bude aktivní pouze 
po výběru položky User Manual (Uživatelská 
příručka) v rozevírací nabídce Help (Nápověda). 
Na nepodporovaném zobrazovacím zařízení s 
podporou DDC/CI jsou k dispozici pouze karty 
Help (Nápověda) a Options (Možnosti).
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Help>Version (Nápověda>Verze) – Tato 
možnost bude aktivní pouze po výběru 
položky Version (Verze) v rozevírací nabídce 
Help (Nápověda). Na nepodporovaném 
zobrazovacím zařízení s podporou DDC/CI 
jsou k dispozici pouze karty Help (Nápověda) a 
Options (Možnosti).

Context Sensitive menu (Místní nabídka)
Context Sensitive Menu (Místní nabídka) je 
ve výchozí konfiguraci Aktivována. Nabídka 
bude zobrazena po zaškrtnutí položky Enable 
Context Menu (Povolit místní nabídku) v části 
Options > podokno Preferences (Možnosti > 
podokno Předvolby).

Context Menu (Místní nabídka) obsahuje 3 
položky:
• SmartControl Lite - po výběru se zobrazí

obrazovka About (O) aplikaci.
• Select Preset (Vybrat předvolbu) – nabízí

hierarchickou nabídku uložených předvoleb 
pro okamžité použití. Aktuálně vybraná 
předvolba je označena zaškrtnutím. V 
rozevírací nabídce lze rovněž vybrat položku 
Předvolby výrobce.

• Tune Display (Ladění zobrazení) – otevře
ovládací panel SmartControl Lite.

Aktivovaná nabídka hlavního panelu
Nabídku hlavního panelu lze zobrazit klepnutím 
pravým tlačítkem myši na ikonu SmartControl 
Lite na hlavním panelu. Klepnutím levým 
tlačítkem lze spustit aplikaci.

Hlavní panel obsahuje pět položek:
• Help (Nápověda) – přístup k souboru

s User Manual (uživatelskou příručkou): 
Otevře soubor s User Manual (uživatelskou 
příručkou) v okně výchozího prohlížeče.

• Technical Support (Odborná pomoc) –
zobrazí stránku odborné pomoci.

• Check for Update (Vyhledat aktualizace) –
zobrazí úvodní stránku PDI a porovná verzi 
uživatele s nejaktuálnější dostupnou verzí.

• About (O aplikaci) – zobrazí podrobné
referenční informace: verze produktu, 
informace o vydání a název produktu.

• Exit (Konec) - ukončí SmartControl Lite
Chcete-li znovu spustit funkci SmartControl Lite, 
vyberte položku SmartControl Lite z nabídky 
Program, poklepejte na ikonu na pracovní ploše 
počítače nebo restartujte počítač.
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Deaktivovaná nabídka hlavního panelu
Když je hlavní panel deaktivován ve složce 
Preference (Předvolby), je k dispozici pouze 
část EXIT (KONEC). Chcete-li funkci 
SmartControl Lite zcela odstranit z hlavního 
panelu, deaktivujte položku Run at Startup 
(Spustit při startu) v části Options>Preferences 
(Možnosti>Předvolby).

 Poznámka
Veškeré ilustrace v této části jsou pouze 
orientační. Verze softwaru SmartControl se 
může změnit bez předchozího upozornění. 
Vždy navštivte oficiální webové stránky Portrait 
na adrese www.portrait.com/dtune/phl/enu/
index a stáhněte si nejnovější verzi softwaru 
SmartControl.
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Obraz/displej
Typ panelu LCD TFT-LCD
Podsvícení LED
Velikost panelu 18,5" Š (47 cm)
Poměr stran 16:9
Rozteč obrazových bodů 0,3 x 0,3 mm
Jas 200 cd/m² 
SmartContrast 10.000.000:1
Kontrastní poměr (typ.) 700:1
Doba odezvy (typická) 5ms
Optimální rozlišení 1366 x 768 při 60 Hz
Zorný úhel 90° (H) / 65° (V) při C/R > 10 
Barevnost displeje 16,7M
Vertikální obnovovací frekvence 56Hz - 76Hz
Horizontální frekvence 30kHz - 83kHz
sRGB ANO
Možnosti připojení
Vstup signálu 	VGA	(analogový)(193V5LSB2);HDMI(193V5LHSB2)
Vstupní signál Oddělená synchronizace, synchronizace podle zelené
Usnadnění

Usnadnění pro uživatele

Jazyky nabídky OSD
Angličtina, němčina, španělština, řečtina, francouzština, italština, 
maďarština, holandština, portugalština, brazilská portugalština, 
ruština, polština, švédština, finština, turečtina, čeština, ukrajinština, 
zjednodušená čínština, tradiční čínština, japonština, korejština

Další usnadnění Zámek Kensington
Kompatibilita s technologií 
Plug & Play

DDC/CI, sRGB, Windows 8/ Windows 7/ Vista/XP, Mac OSX, 
Linux

Podstavec
Náklon -3/+10 

193V5LSB2:
Napájení 
Zapnuto 13,88W (typ.), 14,48W (max.)
Spánek (Pohotovost) 0,5W
Vypnuto 0,5W
Indikátor napájení Zapnuto: Bílá, Pohotovostní režim/režim spánku: Bílá (bliká)
Napájení Vypálení, 100-240VAC, 50-60Hz
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Výrobek s podstavce (ŠxVxH) 437 x 338 x 170 mm
Výrobek bez podstavce (ŠxVxH) 437 x 273 x 48 mm
Hmotnost
Výrobek s podstavcem 2,147kg(LED)
Výrobek bez podstavce 1,940kg(LED)
Výrobek s obalem 3,014kg(LED)
Provozní podmínky
Teplotní rozsah (provoz) 0°C až 40 °C
Teplotní rozsah (mimo provoz) -20°C až 60°C
Relativní vlhkost 20% až 80%
MTBF 30 000 hod(LED)

Ekologie
ROHS ANO
EPEAT Silver (www.epeat.net)
Balení 100% recyklovatelný
Energy Star ANO
Shoda a normy
Prohlášení o shodě CE Mark, FCC Class B, EAC, SEMKO, BSMI, cETLus, 

ISO9241-307
Opláštění
Barva Černá
Povrchová úprava Textura

	Poznámka
1.	 Certifikát EPEAT Gold nebo Silver je platný pouze tam, kde společnost Philips zaregistruje produkt. 
Informace o stavu registrace ve vaší zemi viz www.epeat.net.

2.	 Tyto údaje se mohou změnit bez předchozího oznámení. Stáhněte si nejnovější verzi letáku z webu
www.philips.com/support.

Rozměry

193V5LHSB2:
Napájení 
Zapnuto 15.24W (typ.),	17.65W	(max.)
Spánek	(Pohotovost) 0,5W
Vypnuto 0,5W
Indikátor	napájení	 Zapnuto:	Bílá,	Pohotovostní	režim/režim	spánku:	Bílá	(bliká)
Napájení Vypálení,	100-240VAC,	50-60Hz
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4.1	 Režimy rozlišení a předvoleb

Maximální rozlišení
1366 x 768 při 60 Hz 

Vodorovná 
frekvence 

(kHz)

Rozlišení Svislá 
frekvence 

(Hz)

31.47 720 x 400 70.09

31.47 640 x 480 59.94

35 640 x 480 66.67

37.86 640 x 480 72.81

37.5 640 x 480 75

37.88 800 x 600 60.32

46.88 800 x 600 75

48.36 1024 x 768 60

60.02 1024 x 768 75.03

44.77 1280 x 720 59.86

63.89 1280 x 1024 60.02

79.98 1280 x 1024 75.03

47.71 1366 x 768 59.79

	 Poznámka
Upozorňujeme vás, že tento monitor funguje 
nejlépe při nativním rozlišení 1366 x 768 při 
60 Hz. Pro dosažení optimální kvality zobrazení 
dodržujte toto doporučené rozlišení.
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5. Řízení spotřeby
Pokud je v daném počítači nainstalován software 
nebo videokarta vyhovující normě DPM 
organizace VESA, monitor dokáže automaticky 
snížit svou spotřebu energie, není-li používán. 
Pokud počítač rozpozná vstup z klávesnice, 
myši nebo jiného vstupního zařízení, monitor se 
automaticky „probudí“. Následující tabulka uvádí 
spotřebu energie a signalizaci této funkce pro 
automatickou úsporu energie:

193V5LSB2:  
Definice řízení spotřeby

Režim VESA Video H-synch. V-synch. Spotřeba energie Barva indikátoru LED 

Aktivní ZAP. Ano Ano 13,88W (typ.) Bílá

Spánek VYP. Ne Ne 0,5W (typ.) Bílá (bliká) 

Vypnuto VYP. - - 0,5W (typ.) VYP.

Následující konfigurace se používá při měření 
energetické spotřeby tohoto monitoru.

• Nativní rozlišení: 1366 x 768
• Kontrast: 50%
• Jas: 200 nitů
• Barevná teplota: 6500 K s plně bílým

vzorkem

Poznámka
Tyto údaje se mohou změnit bez předchozího 
oznámení.

193V5LHSB2:		
Definice	řízení	spotřeby

Režim	VESA Video	 H-synch.	 V-synch.	 Spotřeba	energie Barva	indikátoru	LED	

Aktivní ZAP. Ano Ano Bílá

Spánek	 VYP. Ne Ne 0,5W	(typ.) Bílá	(bliká)	

Vypnuto VYP. - - 0,5W	(typ.) VYP.

15.24W (typ.),	
17.65W	(max.)
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Lead-free Product
Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

EPEAT
(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 
51 environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Benefits of EPEAT
Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 

means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards 

• EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

• EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

• EN55024:2010 (Immunity requirement of
Information Technology Equipment).

• EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

• EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

• 2006/95/EC (Low Voltage Directive).
• 2004/108/EC (EMC Directive).
• 2009/125/EC (ErP Directive, EC No. 

1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on ISO9000
level.

The product also comply with the following 
standards 

• ISO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

• GS EK1-2000:2011 (GS mark requirement).
• prEN50279:1998 (Low Frequency Electric

and Magnetic fields for Visual Display).
• MPR-II (MPR:1990:8/1990:10 Low

Frequency Electric and Magnetic fields).

Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 

www.energystar.gov
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meets the ENERGY STAR® guidelines for 
energy efficiency.

	 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)
	 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  

However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

• Reorient or relocate the receiving antenna.
• Increase the separation between the

equipment and receiver.
• Connect the equipment into an outlet on

a circuit different from that to which the
receiver is connected.

• Consult the dealer or an experienced
radio/TV technician for help.

	 Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device.

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following 
two conditions: (1) this device may not cause 
harmful interference, and (2) this device must 
accept any interference received, including 
interference that may cause undesired 
operation.

Commission Federale de la Communication 
(FCC Declaration)
	 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de l'article 
15 Des règles de la FCC. Ces limites sont 
conçues de façon à fourir une  protection 
raisonnable contre les interférences nuisibles 
dans le cadre d'une installation résidentielle.  

CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  
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Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

• Réorienter ou déplacer l’antenne de
réception.

• Augmenter la distance entre l’équipement
et le récepteur.

• Brancher l’équipement sur un autre circuit
que celui utilisé par le récepteur.

• Demander l’aide du marchand ou d’un
technicien chevronné en radio/télévision.
Toutes modifications n'ayant pas reçu
l'approbation des services compétents
en matière de conformité est susceptible
d'interdire à l'utilisateur l'usage du présent
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice
The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so 
on) should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)
Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften.

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III ¤ 5 Abs. 4 der Röntgenverordnung erfüllt 
sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß

1.	 Reparaturen nur durch Fachpersonal
durchgeführt werden.

2.	 	nur original-Ersatzteile verwendet werden. 
3.	 	bei Ersatz der Bildröhre nur eine

bauartgleiche eingebaut wird.

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

	 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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6. Informace o regulaci

China RoHS 
The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

中国能源效率标识 
根据中国大陆《能源效率标识管理办法》，本显示器符合以下要求：

关闭状态能耗（W)
能源效率(cd/W)

< 0.5
> 1.05

1级
GB 21520-2008

能效等级
能效标准

详细有关信息请查阅中国能效标识网：http://www.energylabel.gov.cn/

《废弃电器电子产品回收处理管理条例》提示性
说明

为了更好地关爱及保护地球，当用户不再需要此
产品或产品寿命终止时，请遵守国家废弃电器电
子产品回收处理相关法律法规，将其交给当地具
有国家认可的回收处理资质的厂商进行回收处

理。

EU Energy Label

The European Energy Label informs you on 
the energy efficiency class of this product. 
The greener the energy efficiency class of this 
product is the lower the energy it consumes. 

On the label, you can find the energy efficiency 
class, the average power consumption of 
this product in use and the average energy 
consumption for 1 year. 

Note 
The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.

零部件名
称

有害物质

铅
（Pb） 

汞
（Hg） 

镉
（Cd） 

六价铬

（Cr(VI)） 
多溴联
苯（PBB） 

多溴二苯
醚（PBDE） 

塑料外框 O O O O O O

后壳 O O O O O O

LCD  
panel 

CCFL 
X X O O O O

LED 
X O O O O O

电路板组件 
X O O O O O

底座 O O O O O O

电源线 X O O O O O

其他线材 X O O O O O

遥控器 X O O O O O

*：电路板组件包括印刷电路板及其构成的零部件，如电阻、电容、集成电路、连接器等。 
本表格依据SJ/T 11364的规定编制。 
O：表示该有害物质在该部件所有均质材料中的含量均在GB/T 26572规定的限量要求以下。

X：表示该有害物质至少在该部件的某一均质材料中的含量超出GB/T 26572规定的限量要求。 

上表中打“X”的部件中，应功能需要，部分有害物质含量超出GB/T 26572规定的限量要求，但是符合欧盟

RoHS法规要求(属于豁免部分)。 

b. 另按照《废弃电器电子回收处理条列》，必须加上「环保使用期限说明」及「《废弃

电器电子回收处理条列》提示性说明」，范例如下所述，以简体中文表示:

环保使用期限说明 

该电子电气产品含有某些有害物质，在环保使用期限内可以放心使用，超过环保使用期

限之后则应该进入回收循环系统。 

中国大陆RoHS 
根据中国大陆《电子电气产品有害物质限制使用标识要求》，以下部分列出了本产品中可能包含的有害物质的名称和含

量 

本表适用之产品

显示器 、平板电视 、监视器 

有害物质
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7. Péče o zákazníky a záruka
Druhy pixelových vad
Vady pixelů a subpixelů se na obrazovce 
projevují různými způsoby. Existují dva druhy 
vad pixelu a v rámci těchto druhů je několik 
typů subpixelových vad.

Defekty světlých bodů
Defekty světlých bodů se projevují jako 
obrazové body nebo dílčí obrazové body, které 
vždy svítí nebo jsou 'aktivní'. Světlý bod je dílčí 
obrazový bod, který vystupuje z obrazovky, když 
je na monitoru zobrazena tmavá plocha. Existují 
následující typy defektů světlých bodů:

Jeden červený, zelený nebo modrý subpixel

Dva sounáležící subpixely:
-- červený + modrý = fialový
-- červený + zelený = žlutý
-- zelený + modrý = světle modrý

Tři sounáležící rozsvícené subpixely (jeden bílý 
pixel).

7. Péče o zákazníky a záruka

7.1	 Postup při vadných pixelech 
plochého panelu společnosti 
Philips

Společnost Philips se snaží dodávat výrobky 
nejvyšší kvality. Používá několik nejpokročilejších 
výrobních postupů výroby v tomto odvětví a 
prosazuje přísnou kontrolu kvality. Defektům 
obrazových bodů nebo dílčích obrazových 
bodů u panelů TFT LCD, které se používají 
pro ploché monitory, se nicméně někdy nedá 
zabránit. Žádný výrobce nemůže zaručit, že 
všechny panely budou bez defektů obrazových 
bodů, ale společnost Philips zaručuje, že každý 
monitor s nepřijatelným počtem defektů bude 
v rámci záruky opraven nebo vyměněn. Tento 
text vysvětluje jednotlivé druhy defektů na 
pixelech a určuje únosnou úroveň chybovosti 
pro každý druh. Aby bylo možné uplatnit záruční 
opravu nebo výměnu, musí počet defektních 
obrazových bodů panelu TFT LCD přesáhnout 
tuto úroveň únosnosti. Na monitoru například 
nesmí být více defektních dílčích obrazových 
bodů než 0,0004 %. Dále, protože některé typy 
kombinací vad pixelů jsou lépe postřehnutelné 
než jiné, stanovuje pro ně společnost Philips 
ještě větší nároky na kvalitu. Tato norma se 
dodržuje celosvětově.

Pixely a subpixely
Pixel, neboli obrazovkový bod, se skládá ze tří 
subpixelů v základních barvách červené, zelené a 
modré. Když je mnoho pixelů pohromadě, tvoří 
obraz. Když všechny subpixely určitého pixelu 
svítí, jeví se tyto tři subpixely společně jako 
jediný bílý pixel. Když jsou všechny tmavé, jeví 
se tyto tři subpixely jako jeden černý pixel. Další 
kombinace rozsvícených a tmavých subpixelů se 
jeví jako pixely různých barev.

subpixelysubpixelysubpixely

pixely
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	 Poznámka
Červený nebo modrý světlý bod musí být o 
více než 50 procent jasnější, než sousední body; 
zelený světlý bod je o 30 procent jasnější, než 
sousední body.

Defekty tmavých bodů
Defekty tmavých bodů se projevují jako 
obrazové body nebo dílčí obrazové body, které 
nikdy nesvítí nebo jsou „neaktivní“. Tmavý bod je 
dílčí obrazový bod, který vystupuje z obrazovky, 
když je na monitoru zobrazena světlá plocha. 
Existují následující typy defektů tmavých bodů:

Vzdálenost pixelových vad
Protože vady pixelů a subpixelů stejného 
typu, které se vyskytují blízko sebe, mohou být 
patrnější, určuje společnost Philips i tolerance na 
vzdálenost vad pixelů.

Tolerance vad pixelů
Aby bylo možné uplatnit opravu nebo výměnu 
kvůli defektním obrazovým bodům v záruční 
době, musí panel TFT LCD plochého monitoru 
Philips vykazovat defekty obrazových bodů 
nebo dílčích obrazových bodů, které překračují 
tolerance uvedené v následujících tabulkách.

KAZY JASNÝCH BODŮ PŘIJATELNÝ POČET VAD
1 trvale svítící bod 3
2 sousední trvale svítící body 1
3 sousední trvale svítící body (nebo 1 trvale svítící bílý bod) 0
Vzdálenost mezi dvěma kazy jasných bodů* >15 mm
Celkový počet kazů jasných bodů všech typů 3
KAZY ČERNÝCH BODŮ PŘIJATELNÝ POČET VAD
1 tmavý bod 5 nebo méně
2 sousední tmavé body 2 nebo méně
3 sousední tmavé body 0
Vzdálenost mezi dvěma kazy černých bodů* >15 mm
Celkový počet kazů černých bodů všech typů 5 nebo méně
KAZy bodů celkem PŘIJATELNÝ POČET VAD
Celkový počet kazů jasných nebo černých bodů všech typů 5 nebo méně

	 Poznámka
1.	 1 nebo 2 sousední vadné body (1 barva) = 1 vadný bod
2.	 Tento monitor je kompatibilní se standardem ISO 9241-307. ( ISO 9241-307: Ergonimický
požadavek, analýza a metody testování shody pro elektronická zobrazovací zařízení)

3.	 Norma ISO9241-307 je následníkem dřívější normy ISO13406, která byla zrušena organizací ISO
(International Organisation for Standardisation) ke dni: 2008-11-13
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7.2	 Péče o zákazníky & záruka

Podrobné informace o záruce a požadavku na dodatečnou podporu platné pro vaši oblast najdete na 
webu www.philips.com/support.  Rovněž můžete kontaktovat místní centrum péče o zákazníky na níže 
uvedených telefonních číslech.

Kontaktní informace pro oblast ZÁPADNÍ EVROPY:
Země ASC Číslo zákaznické péče Cena
Germany Siemens I&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0,10

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0,09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Italy A-novo +39 840 320 041 € 0,08

Netherlands E Care +31 0900 0400 063 € 0,10

Denmark A-novo +45 3525 8761 Local call tariff

Norway A-novo +47 2270 8250 Local call tariff

Sweden A-novo +46 08 632 0016 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Austria Siemens I&S +43 0810 000206 € 0,07

Belgium E Care +32 078 250851 € 0,06

Luxembourg E Care +352 26 84 30 00 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktní informace pro oblast STŘEDNÍ A VÝCHODNÍ EVROPY:
Země Telefonní středisko ASC Číslo zákaznické péče
Belarus NA IBA +375 17 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Estonia NA FUJITSU +372 6519900

Latvia NA “ServiceNet LV” Ltd. +371 7460399

Lithuania NA UAB "Servicenet" +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

Serbia & 
Montenegro

NA Kim Tec d.o.o. +381 11 20 70 684

Slovenia NA PC H.and +386 1 530 08 24

Ukraine

NA Comel +380 562320045 

NA
Topaz-Service 
Company

+38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155

Turkey NA Techpro +90 212 444 4 832 

Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331 

NA Profi Service +36 1 814 8080

Kontaktní informace pro oblast LATINSKÉ AMERIKY:
Země Telefonní středisko Číslo zákaznické péče
Brazil

Vermont 
0800-7254101

Argentina 0800 3330 856

Kontaktní informace pro Čínu:

Čína
Číslo zákaznické péče: 4008 800 008

Kontaktní informace pro SEVERNÍ AMERIKU:
Země Telefonní středisko ASC Číslo zákaznické péče
U.S.A. EPI-e-center Qwantech (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Kontaktní informace pro oblast APMEA:

Země Telefonní 
středisko ASC Číslo zákaznické péče

Australia NA AGOS NETWORK PTY LTD 1300 360 386

New Zealand NA Visual Group Ltd. 0800 657447

Hong Kong / Macau NA Smart Pixels Technology Ltd.
Hong Kong:Tel: +852 2619 9639 
Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396 
SMS: PHILIPS to 56677 

Indonesia NA
PT. Gadingsari elektronika 
Prima

Tel: 62 21 75909053, 75909056, 
7511530         

South Korea NA Alphascan Displays, Inc. 1661 – 5003

Malaysia NA
After Market Solutions (CE) 
Sdn Bhd

603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer 
Care Center)

(65) 6882 3999

Taiwan
PCCW 
Teleservices 
Taiwan 

FETEC.CO 0800-231-099

Thailand NA
Axis Computer System Co., 
Ltd.

(662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888 

United Arab 
Emirates

NA
AL SHAHD COMPUTER 
L.L.C

00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA
FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City 
+84 5113.562666 Danang City 
+84 5113.562666 Can tho Province

Philippines NA Glee Electronics, Inc.
(02) 633-4533 to 34, 
(02) 637-6559 to 60

Sri Lanka NA
no distributor and/or service 
provider currently

Bangladesh NA
Distributor: Computer Source 
Ltd (warranty buy-out)

880-2-9141747, 9127592 
880-2-8128848 / 52

Nepal NA
Distributor: Syakar Co. Ltd 
(warranty buy-out)

977-1-4222395 

Cambodia NA
Distributor: Neat Technology 
Pte Ltd (Singapore) (warranty 
buy-out)

855-023-999992
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8.	 �Odstraňování problémů a 
časté dotazy

8.1	 Odstraňování problémů

Na této stránce jsou uvedeny problémy, 
které může odstranit uživatel. Pokud problém 
přetrvává i po vyzkoušení těchto řešení, 
kontaktujte zástupce služeb pro zákazníky 
společnosti Philips.

	 Běžné problémy

Žádný obraz (indikátor LED napájení nesvítí)
•	 Zkontrolujte, zda je napájecí kabel připojen 

k elektrické zásuvce a do zadní části 
monitoru.

•	 Nejdříve zkontrolujte, zda se vypínač na 
přední straně monitoru nachází ve OFF 
(VYPNUTÉ) poloze a stiskněte jej do ON 
(ZAPNUTÉ) polohy.

Žádný obraz (indikátor LED napájení je bílý)
•	 Zkontrolujte, zda je zapnutý počítač.
•	 Zkontrolujte, zda je kabel signálu řádně 

připojen k počítači.
•	 Zkontrolujte, zda nejsou ohnuté kolíky na 

připojovací straně kabelu monitoru. Pokud 
ano, opravte nebo vyměňte kabel.

•	 Pravděpodobně je aktivována funkce řízení 
spotřeby

Obrazovka říká

Attention

Check cable connection

•	 Zkontrolujte, zda je kabel monitoru řádně 
připojen k počítači. (Rovněž viz Stručná 
příručka).

•	 Zkontrolujte, zda nejsou ohnuté kolíky 
kabelu monitoru.

•	 Zkontrolujte, zda je zapnutý počítač.

Tlačítko AUTO nefunguje

•	 Automatická funkce je použitelná pouze 
v režimu VGA-analogový. Pokud výsledek 
není uspokojivý, můžete provést ruční 
úpravy prostřednictvím nabídky OSD.

	 Poznámka
Automatická funkce není použitelná v 
režimu DVI-digitální, protože je zbytečná.

Viditelné známky kouře nebo jiskření
•	 Neprovádějte žádné kroky pro odstraňování 

problémů
•	 Pro zajištění bezpečnosti ihned odpojte 

monitor od zdroje napájení
•	 Ihned kontaktujte zástupce služeb pro 

zákazníky společnosti Philips.

	 Problémy se zobrazením

Obraz není vystředěn
•	 Upravte polohu obrazu pomocí funkce 

„Auto“ v hlavních ovládacích prvcích OSD.
•	 Upravte polohu obrazu pomocí položek 

Phase/Clock (Fáze/frekvence) v části Setup 
(Nastavení) v OSD Main Controls (Hlavní 
ovládací prvky OSD). Tato funkce je platná 
pouze v režimu VGA.

Obraz se chvěje na obrazovce
•	 Zkontrolujte, zda je kabel signálu řádně a 

bezpečně připojen ke grafické desce nebo k 
počítači.

Dochází ke svislému blikání

•	 Upravte polohu obrazu pomocí funkce 
„Auto“ v hlavních ovládacích prvcích OSD.

•	 Omezte svislé pruhy pomocí položek 
Phase/Clock (Fáze/frekvence) v části Setup 
(Nastavení) v OSD Main Controls (Hlavní 
ovládací prvky OSD). Tato funkce je platná 
pouze v režimu VGA.

Dochází k vodorovnému blikání
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•	 Upravte polohu obrazu pomocí funkce 

„Auto“ v hlavních ovládacích prvcích OSD.
•	 Omezte svislé pruhy pomocí položek 

Phase/Clock (Fáze/frekvence) v části Setup 
(Nastavení) v OSD Main Controls (Hlavní 
ovládací prvky OSD). Tato funkce je platná 
pouze v režimu VGA.

Obraz je rozmazaný, nevýrazný nebo příliš 
tmavý
•	 Upravte kontrast a jas na obrazovce OSD.

„Dosvit“, „vypálení“ nebo „zobrazení duchů“ 
zůstane po vypnutí napájení.
•	 Dlouhodobé nepřerušované zobrazení 

nehybného nebo statického obrazu může 
způsobit „vypálení“ obrazovky, rovněž 
známé jako „dosvit“ nebo „zobrazení 
duchů“. „Vypálení“, „dosvit“ nebo 
„zobrazení duchů“ je dobře známý jev 
u technologie panelů LCD. V mnoha 
případech „vypálení“, „dosvit“ nebo 
„zobrazení duchů“ postupně zmizí po 
určité době mimo provoz.

•	 Před ponecháním monitoru bez dozoru 
vždy aktivujte spořič obrazovky.

•	 Bude-li na vašem monitoru LCD zobrazen 
neměnící se statický obsah, vždy aktivujte 
aplikaci pro pravidelnou obnovu obrazovky.

•	 Vážné příznaky „vypálení“, „dosvitu“ nebo 
„zobrazení duchů“ nezmizí a nelze je 
opravit. Na výše uvedené poškození se 
nevztahuje záruka.

Obraz je zdeformovaný. Text je nejasný nebo 
rozmazaný.
•	 Nastavte rozlišení zobrazení počítače 

na stejný režim, v jakém se nachází 
doporučené nativní rozlišení obrazovky 
monitoru.

Na obrazovce se objevují zelené, červené, 
modré, tmavé a bílé tečky
•	 Zbývající body jsou normální vlastností 

tekutých krystalů používaných současnou 
technologií. Další podrobnosti viz pravidla 
pro obrazové body.

Světlo indikátoru „napájení“ je příliš silné a 
ruší
•	 Můžete nastavit intenzitu světla indikátoru 

„napájení“ v části Power LED (Indikátor 
LED napájení) v části Setup (Nastavení) 
v OSD Main Controls (Hlavní ovládací 
prvky nabídky OSD).

Potřebujete-li další pomoc, viz seznam 
Informační střediska pro zákazníky a kontaktujte 
zástupce služeb pro zákazníky společnosti 
Philips.

8.2	 Obecné časté dotazy

OTÁZKA 1: 	Když nainstaluji svůj monitor, co 
mám udělat, když se na obrazovce 
zobrazí zpráva „Cannot display this 
video mode“ (Tento režim videa 
nelze zobrazit)?

Odpověď:	 Doporučené rozlišení pro tento 
monitor: 1366 x 768 při 60 Hz.

•	 Odpojte všechny kabely, potom připojte 
počítač k monitoru, který jste použili předtím.

•	 V Start Menu (nabídce Start) operačního 
systému Windows vyberte Settings/Control 
Panel (Nastavení/Ovládací panely). V okně 
Control Panel (Ovládací panely) vyberte 
ikonu Display (Zobrazení). Na panelu Display 
Control (Zobrazení – vlastnosti) vyberte kartu 
„Settings“ (Nastavení). Na kartě nastavení 
v poli označeném „desktop area“ (pracovní 
plocha) přesuňte posuvník na 1366 x 768 
obrazových bodů.

•	 Klepněte na „Advanced Properties“ (Upřesnit), 
nastavte položku Refresh Rate (Obnovovací 
frekvence) na 60 Hz a potom klepněte na OK.

•	 Restartujte počítač a zopakováním kroku 2 a 3 
ověřte, zda je počítač nastaven na 1366 x 768 
při 60 Hz.

•	 Vypněte počítač, odpojte starý monitor a 
znovu připojte monitor LCD Philips.

•	 Zapněte monitor a potom zapněte počítač.

OTÁZKA 2: 	Jaká je doporučená obnovovací 
frekvence monitoru LCD?

Odpověď:	 Doporučená obnovovací frekvence 
u monitorů LCD je 60 Hz. V případě 
jakéhokoli rušení na obrazovce ji 
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můžete nastavit na 75 Hz a uvidíte, 
zda rušení zmizí.

OTÁZKA 3: 	Co jsou soubory .inf a .icm na disku 
CD-ROM? Jak lze nainstalovat 
ovladače (.inf a .icm)?

Odpověď:	 Jedná se o soubory ovladače 
monitoru. Při instalaci ovladačů 
postupujte podle pokynů v 
uživatelské příručce. Při první instalaci 
bude počítač pravděpodobně 
požadovat ovladače monitoru 
(soubory .inf a .icm) nebo disk s 
ovladači. Postupujte podle pokynů a 
vložte (doprovodný disk CD-ROM), 
který je součástí této sady. Ovladače 
monitoru (soubory .inf a .icm) 
budou nainstalovány automaticky.

OTÁZKA 4: 	Jak mám upravit rozlišení?
Odpověď:	 Dostupná rozlišení určuje grafická 

karta/ovladač grafiky a monitor. 
Požadované rozlišení můžete vybrat 
v části Control Panel (Ovládací 
panely) systému Windows® v části 
„Display properties“ (Zobrazení - 
vlastnosti).

OTÁZKA 5: 	Co když se během nastavení 
monitoru ztratím prostřednictvím 
nabídky OSD?

Odpověď:	 Jednoduše stiskněte tlačítko OK a 
potom volbou „Reset“ (Obnovit) 
obnovte všechna původní nastavení 
výrobce.

OTÁZKA 6: 	Je obrazovka LCD odolná proti 
poškrábání?

Odpověď:	 Obecně se doporučuje nevystavovat 
povrch panelu nadměrným úderům 
a chránit jej před ostrými nebo 
tupými předměty. Při manipulaci 
s monitorem nevyvíjejte na povrch 
panelu žádný tlak ani sílu. Mohlo by 
to negativně ovlivnit vaše záruční 
podmínky.

OTÁZKA 7: 	Jak lze čistit povrch monitoru 
LCD?

Odpověď:	 Pro běžné čištění použijte čistý 

a měkký hadřík. Pro důkladné 
čištění použijte izopropyl 
alkohol. Nepoužívejte žádná jiná 
rozpouštědla, jako etylalkohol, 
etanol, aceton, hexan atd.

OTÁZKA 8: 	Lze měnit nastavení barev 
monitoru?

Odpověď:	 Ano, nastavení barev můžete změnit 
prostřednictvím nabídky OSD podle 
následujících kroků:

•	 Stisknutím tlačítka „OK“ zobrazte nabídku 
OSD.

•	 Stisknutím tlačítka „Down“ (Šipka dolů) 
vyberte volbu „Color“ (Barva) a stisknutím 
tlačítka „OK“ přejděte na nastavení barev. K 
dispozici jsou tři nastavení (viz níže).
1.	 Color Temperature (Teplota barev): 

k dispozici je dvou nastavení: 6500K a 
9300K. Při nastavení v rozsahu 6500K 
vypadají barvy na panelu „teplé s 
červenobílým barevným tónem“, zatímco 
při nastavení teploty 9300K vypadají 
barvy na panelu „studené s modrobílým 
barevným tónem“.

2.	 sRGB: standard pro zajištění správné 
přenosu barev mezi různými zařízeními 
(např. digitální fotoaparáty, monitory, 
tiskárny, skenery atd.)

3.	 User Define (Uživatelské): uživatel si může 
zvolit vlastní nastavení barev upravením 
červené, zelené a modré složky.

	 Poznámka:
Měření světla barvy, které vyzařuje předmět při 
zahřívání. Toto měření je vyjádřeno v absolutním 
měřítku (stupně Kelvina). Nižší teploty Kelvina, 
například 2004K, jsou červené; vyšší teploty, jako 
například 9300K, jsou modré. Neutrální teplota je 
bílá při 6504K.

OTÁZKA 9: 	 Lze připojit tento monitor LCD 
k libovolnému počítači, pracovní 
stanici nebo počítači Mac?

Odpověď:	 Ano. Všechny monitory LCD 
Philips jsou plně kompatibilní se 
standardními počítači, počítači 
Mac a pracovními stanicemi. Pro 
připojení monitoru k systému 
Mac může být zapotřebí kabelový 
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adaptér. Další informace vám 
poskytne nejbližší obchodní 
zástupce Philips.

OTÁZKA 10:	 Jsou monitory Philips LCD 
vybaveny technologií Plug-and-
Play?

Odpověď:	 Ano, tyto monitory jsou 
kompatibilní s technologií Plug-
and-Play v operačním systému 
Windows 8, Windows 7, Vista, XP, 
NT, Mac OSX a Linux. 

OTÁZKA 11:	 Co znamená lpění obrazu, 
vypálení obrazu, dosvit nebo 
„duch“ v souvislosti s panely 
LCD?

Odpověď:	 Dlouhodobé nepřerušované 
zobrazení nehybného nebo 
statického obrazu může způsobit 
„vypálení“ obrazovky, rovněž 
známé jako „dosvit“ nebo 
„zobrazení duchů“. „Vypálení“, 
„dosvit“ nebo „zobrazení duchů“ 
je dobře známý jev u technologie 
panelů LCD. V mnoha případech 
„vypálení“, „dosvit“ nebo 
„zobrazení duchů“ postupně zmizí 
po určité době mimo provoz.
Před ponecháním monitoru bez 
dozoru vždy aktivujte spořič 
obrazovky.
Bude-li na vašem monitoru LCD 
zobrazen neměnící se statický 
obsah, vždy aktivujte aplikaci pro 
pravidelnou obnovu obrazovky.

	 Výstraha
Selhání aktivace spořiče obrazovky nebo aplikace 
pro pravidelné aktualizování obrazovky může mít 
za následek vážné příznaky „vypálení“, „dosvitu“ 
nebo „zdvojeného dosvitu“, které nezmizí a 
nelze je opravit. Na výše uvedené poškození se 
nevztahuje záruka.

OTÁZKA 12:	 Proč se na displeji nezobrazuje 
ostrý text a proč mají 
zobrazené znaky zubaté okraje?

Odpověď:	 Váš monitor nejlépe pracuje při 
svém nativním rozlišení 1366 
x 768 při 60 Hz. Používejte 
toto rozlišení pro dosažení 
optimálního zobrazení.
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